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TRACTRIX SOFTWARE
RASTER TO VECTOR CONVERSION TUTORIAL

What comes out of your scanner?

Imagine we’ve scanned this picture of a pair of boots and we’re viewing it on our computer
screen (the image shown is from the <tawademao.tif> file in the Examples folder). We see
continuous lines.

But if we zoom-in on the tiny circled area on the trim at the top of the left-hand boot we’d see
a grid of black squares. The scanner creates the ‘lines’ on a computer screen using square
dots, known as ‘pixels’. It’s conventional to refer to them as dots only in the context of
scanner resolutions (dots per inch or dpi). Scanner resolution is always referred to as dpi (dots
per inch) whether you are in the metric (mm) or (1|

Imperial (inch) units of measure. === u
) IIENEEER
Where black dots are clustered together we see lines. IHHNEEEEEEN
NSRS EEE RN
Whe.re white dots are clu§tered together we see =====. =========...
nothing (although the white dots are actually there). inEmEE EEEEEEEEEEEEE
_— . . (1 [ [ 1 1] HEEEEEEEEEEEER
Any file in which pictures are saved as a sequence of T T T 11 EEEEEEEEEEEEE
; ; ; IINEEEEEEEEEEEEEEEEEEE
black afqd whlt;ce or d|‘fferent coloredddor;c.s is caII.ed aII ; ======================
raster |Fz, and any picture presente t. is way is calle EEEEEEEEEEEEEEEEEEEE
a raster image. Scanners create raster images and AENEEEEEEEEEEEEEEEE
. . ENEEEEEEEEEER
nothing else. They cannot create vectors. The same is EEEEEEEEE
true for digital cameras and 'paint' software programs. .========
. . - L[] [
Raster images are wonderful for viewing or printing. [ ]

This is because our eyes and brain interpret what is a

line and what is not. Unfortunately, raster images are completely useless for any computer
software which depends on vector descriptions of lines. CAD, CAM, numerical control and GIS
software can only do their job with vectors. So TracTrix traces the
little dots that form the raster lines and automatically converts
the lines into vectors which you can export as a standard vector
file format. In the illustration to the left you can see how TracTrix
converts the raster image of the boots to vector lines.

To duplicate this, Zoom-in A %R on the boots in

)‘(n‘
<tawademo.tif>, and use Select Area ‘& to select the area
i"?* around the boots.

1= | Vectorize the raster image with by clicking Vectorize.
VYectorizing

Click on Adjust and select Polylines.

Click OK, then Start. The boots will be vectorized.



[ oMy x| . .
o S 3 (R Use the Select tool to click lines that you can see.

Instead of being made up of hundreds of little dots each line is now described by control
points and mathematical coordinates, the descriptions of curves and lines.

These are the vectors.

A single control point on a vector line now represents the corner on the trim that we
previously zoomed-in on.

If we look at the vectors we’ve created on top of the original raster lines (as you can do in
TracTrix) we see something like this:

The vector lines have been created along the dots that make
up the original raster lines. This is at the core of how TracTrix
works.

Why have we devoted so much time to explaining what a
raster is and how it differs from a vector? Because to get the
best out of TracTrix it pays to start with a good quality scan
and use TracTrix raster editing tools to optimize the raster
before it is converted to vectors. Understanding that a raster is made up of masses of little
dots is key to this process.

Creating vectors from rasters

What it takes for Vectorization

There are normally four distinct stages in raster to vector conversion:

1) Scanning the image to be vectorized;

2) Editing the raster image created by the scan, if necessary;
3) Conversion to vectors;

4) Cleaning up the new vectors.

5) Saving the vectors in a specific CAD vector format.

Successful Vectorization Rule #1:

Attention to the preparatory work saves on clean up later.



Scanning

Your scanner provides you with a variety of options. While these settings are quite independent
of TracTrix, your choices from these options can radically alter vectorizing performance. The
two key scanning options to consider before using TracTrix are resolution and bit depth.

Resolution is usually set as a measure of dots per inch (or dpi). This is the number of raster dots
your scanner will create for each inch of paper it scans. This is very important for accurate
vector creation. In general, TracTrix prefers that the lines in the raster image are at least three
pixels wide on screen. More pixels mean a smoother centerline.

By setting the scanner resolution high enough we ensure that lines in the raster contain enough
pixels across their width. At the same time we don't want to set resolution any higher than
necessary because this creates large files and slows down the conversion process.

To see the reason for the 3-pixel width - ™ .
requirement take a look at the picture of " " -

. [ ] [ [ E—
the front of a moccasin. It shows a raster "'E=. I
image consisting of single pixel wide lines. B I 'i=
Take a pencil and try to draw a centerline lll..“. | .=E=E I
through the line of pixels. . lll..=. ll=.... u l
It's quite difficult to draw smooth curves .-ll=. S Rl "R E=
through these pixels. TracTrix experiences ""=n==.==“. ..=.=ll“
the same sort of difficulty. ENEEEEEEENEEEE

The illustration below and to the right is

scanned at four times the previous resolution. Looking across any line you'll see at least three
pixels. It's much easier to draw a continuous smooth line through the centerline of these dense
pixel strings.

Scans with lines at least three pixels wide provide better information for TracTrix to calculate
and create smoother vectors. You can --“I
ensure that your scans have 3-pixel wide II
lines by selecting a high enough resolution
in your scanner’s settings. Next we'll apply
this rule to a real scan.

Scanning directly into TracTrix

Open the Examples folder and open the

tawademo.tif file. Then print it. We will be J—
using the print as an example for scanning E““““““iiiiiiiiﬁ“
into TracTrix.

If you don’t have a scanner, a digital camera can also be used. If you have neither a scanner or a
digital camera use the print for the subsequent vectorizing exercise.



The thinnest line on this print appears to be between 0.010" and 0.020" (0.25mm - 0.5mm)
wide. To scan this to create at least 3 pixels width in the narrower raster lines we need to set a
scanner resolution of 400 dots per inch (dpi).

Place the ‘tawademo’ print in your scanner. Align the edges of the print along the edge of the
scanner bed. (TracTrix can de-skew vectors, but lining up the print now will save you editing
work later.)

Establish a connection to your scanner by choosing iy »mawe Select Source. If your scanner
has a TWAIN interface, you will see its name listed; select it (most desktop scanners are
supported).

Use —» aaure to access the scanning software where you can adjust scanning settings. Choose to
use either the TracTrix interface or the scanner manufacturer’s interface for scanning.

Set the resolution to the 400 dots per inch as suggested for the ‘tawademo’ print.

Next set your scanner to scan the image as a black & white, 1-bit, image. We do this because
‘tawademo’ is a black and white image--it contains no gray-scale tones or colors. Various terms
are used to describe this setting control in different scanner software packages. Look for names
that are synonymous with a 1-bit image such as 1 bit-depth, 1 bit color-depth, line art or

monochrome. G 5 i [ e k) s
Check also that the scanner is set to scan =
at 100% Scaling. j New Acquire an image from a scanner
= Use TracTrix interface...

If your scanner software supports a “g Open... D Read an image from selected TWAIN source
preVieW mOde, click on this. The preVieW __Use manufacturer's interface...
image WI“ appear on your screen 2 = | Read an image from selected TWAIN source
Examine the preview image. You may H Save fs... _ Select source...

. . o Select TWAIN
need to adjust your scanner's brightness “QB p— D/ o St
control to make the lines on the image as
bold, crisp and clear as possible. T acqire
When you are satisfied with the (2 prin )
appearance, click on the button that >
instructs your scanner to complete the J Close
scan (it may be labeled Final, Scan, or [ Properties... || X Exit

something of this sort.)

The scanner will run again and the ‘tawademo’ image will appear in the TracTrix window. By
carefully choosing the scanner settings, you'll have the best possible raster image for
Vectorization in TracTrix.

Successful Vectorization Rule #2:

Good quality vectors start with good quality scans.



Raster editing

AT 4

ih é TracTrix provides a variety of raster editing tools. In this tutorial
we will use the Eraser tool and the Pen tool. The scan should be
open in TracTrix, or open the <tawademo.tif> image instead.

Start by selecting the Zoom tool under the Start tab.

o
Look closely at the blob of dirt outside the text box, (-\
just to the left of the word 'image’. Let us use the “fﬁgfonw

|
eraser to remove it.

tawademo
- | image Again from the Start tab, select the Eraser icon 7| in the Raster
For use with

the TracTrix™ Editing group. The eraser works like a ‘freehand tool.” Move the
tutorial, cursor over the blob. Hold down the left mouse button and drag

back and forth over the blob to erase it. Zoom All g (or roll
your mouse wheel) to display the entire image.

Just because we're using computers
doesn’t mean we have to ignore

pens, erasers, or white-out. If you Save = from the Quick Access Toolbar. The edited file will be
see blemishes on prints, it's often —_— ] .
just as simple to make corrections on saved as <tawademo.tif. TRX> in the Examples folder. TRX is the

them before scanning.

extension to TracTrix native files that store.

Zoom in “\ on the 'feathers' at the

very top of the image. The tips of the top two feathers are missing. / \/A\\
We’'ll use the Raster Pen tool to correct this error. "‘\‘\r,

If you make mistakes use the Eraser tool to correct them.
Don't worry about being too exact. You should end up
with something like this:

Select the Pen tool. &4 The cursor changes to a pen. Right-click/
Properties... ;; set the pen width to 5 pixels. Click OK. Use the Pen tool
to draw in the tips of the feathers.

jﬁ; H Save fs...

Select CALS Type 1 from the File type menu. Enter i ®
‘tawademo.cal’ as the file name; click Save. e

You’ll be prompted for a size and resolution. Select Letter as the
size and 400 dpi resolution; Save.




You've now saved a copy of the raster file that you opened or scanned in, complete with the
edits you made to it.

In this exercise, you chose to save to the CALS format—any supported raster file format could
have been chosen.

You've now used the Eraser to eliminate dirt and the pen to add missing detail. The image is
now ready for Vectorization. Before we go on, take a moment to experiment with zooming in
on the precision of the raster image. Zoom down until you can see the individual pixels (at high
levels of zoom a grid will automatically appear so that you can see the individual pixels).

You should see that the edges of the raster lines are quite jaggy in many places when viewed as
individual pixels. Junctions between lines are often irregular. TracTrix can deal with most of
this. By dealing with the major raster irregularities and omissions you'll assist TracTrix in its
automatic conversion in the next stage.

Successful Vectorization Rule #3:
It's quicker to clean up problems in a raster
before they become bigger problems as vectors.

Converting the raster to vectors

TracTrix has some easy-to-use settings so that you can When would you want outline
adjust to control exactly how TracTrix converts your [ vectorization rather than centerine?
) ' . . ypically you'd use this when you have a
images to vectors. In this exercise we are going to vary large filled raster area in silhouette, such
A A A as a logo, where you want to have vector
these settings to see how TracTrix creates different results definitions of the edges.
See ornament.tif in the Examples folder.
based on the settings you choose. <TracTriw> v
. . <TracT x>
Outline Conversion Architecture
Cadastral
. / ’ Contour
You should have TracTrix open and your tawademo’ scan up on screen. Evploded view
(Open the <tawademo.cal> file if you are returning to the tutorial.) :?0*;‘0‘:;‘3’8
Mechanical

T=%  Click Vectorizing in the Tools tab.

[f"-] . .
Vedorizing  WWhen you first launch TracTrix

Purmnp

the default setting is the basic 5F Selting T
<TracTrix> setting. Sﬁw = Outine] 3 gﬂuﬂhe
LCenterdine
Additional pre-defined settings are provided @ Save
in the menu. s
Drawing entities
Start by choosing the Outline setting in the ngm O Lines, arcs and cicles
menu, then click Adjust. The Trace Settings O Bobines
. . esu:; 2 20 (® Beziers and fines
window appears—notice that the Trace e
method is set to Outline vectorization. This
means TracTrix will create lines along the
outside edges of the raster lines.
€ [ ok || cacel |[ Hep |




Now click on Adjustments. The new window contains settings for the tracing parameters.

The Precision tolerance parameter is set to 0.20 [FHespm—
mm (0.0079”). Why we wouldn’t want absolute £ Tokscarce
. . ,f’f 00079
precision? s Precison
0.008"
There are two primary reasons: The closer you M@ fes )
ustments "
follow your original jaggy raster, the more & Mtk Ao ok i
vector entities you will create, and this can e
create unmanageably large CAD files. Also, the FA N Lt
raster lines are imperfect in the first place 2"
. . . Angle divergence: 1,
because of cumulative discrepancies from S0
original drafting, paper stretch, and scanner e
wobble. There is no point in absolutely C o ][ oo J[ v ]
replicating an already somewhat imperfect
original.

Precision tolerance tells TracTrix to follow the raster lines so that the vectors created are never
more than 0.20 mm away from the original raster. You may want to think of this as the setting
for the level of detail you want from TracTrix. If you prefer to work in inches go to Program
Settings in the Settings tab and change ‘units’ from mm to inches.

The Noise tolerance parameter tells TracTrix what size of speckle is to be ignored. Many raster
images have very small areas of dirt on them where lines may have been erased or dust
particles appear as black specks. As we do not want these to appear as vectors we tell TracTrix
to ignore them. The current setting is 0.20 mm. This means TracTrix will ignore any group of
pixels less than 0.20 mm across.

The other settings enable even finer tuning of TracTrix conversion. To keep this tutorial simple
we'll skip these for now.

Now let's see what happens when you convert the ‘tawademo’ image using these settings. Click
OK. Check that the Outline setting is still showing, then click Start. The cursor changes to an
hourglass.

The progress of the vectorization is shown in the foot of the TracTrix window.

Within a few seconds vectorization is complete and blue vector lines appear overlaying the
black of the ‘tawademo’ raster scan. Note that the outline is filled with blue. Turn off the “fill’ to
show only the outline by clicking the Filled objects button [%..

Zoom in closely L anywhere on the image. Notice how
the blue vector lines smoothly flow around the jaggy
edges of the underlying raster image, always keeping
within the 0.20 mm limit set in the Precision setting.
You'll also see how TracTrix has handled intersections.

Right-click/HOLD &Iy + Drag to activate and use the Pan
tool (also in the Start tab).




Turn the raster layer off by using the Drawing button & icon. You can now see the vector lines

without the black raster lines underneath. To see the underlying raster again click on the 9

button again. Then click the \QW to toggle the display of the vector layer.

Centerline Conversion

When you want to go back and see the entire image, click on the e Zoom all icon.

Now we'll do the conversion again, but this time we'll create centerline vectors. We first have
to delete the outline vectors we just created (Ctrl+A to Select all). Every blue vector line on the
screen will be highlighted with gray control points. Press the Delete key

raster on screen.

Settings menu.

To create centerline vectors press the
Vectorizing button again. Select the
‘Mechanical’ setting from the pull-down

on your keyboard. All the vectors will disappear, leaving the original

The maximum line width setting
enables you to have both centerline
and outline vectorization performed

simultaneously, depending upon
the line widths. We want centerlines

only for this demonstration.

Click on Adjust. The setting for Maximum line thickness, which was previously grayed out, is
now available. Increase this setting to its maximum, 3.0mm.

In Drawing Entities select ‘Beziers and lines’. This will create Bezier vector line segments and
straight line vector line segments and connect individual vector line segments together.

Now click on Adjustments to take a look at the other settings. Adjust the Precision to 0.14 mm.

Leave Noise set to 0.20 mm.

Go back to the Settings screen. Click to
highlight Mechanical in the setting field,
key in ‘Tawa demo’, then click Save. This
creates a permanent record of the setting
with our adjustments. Click OK to close
the Trace settings. Since you saved your
setting, the Mechanical Setting will be
stored for future use.

The words 'Tawa demo’ will appear in the
box.

This shows that the settings you just
saved will be used for the vectorization.
Click Start. TracTrix will convert the raster
image to vectors. This time it will create
vectors which follow the centerlines of
the original lines within the +/- 0.14mm
tolerance set for Precision in the Trace
parameters box.

Industry-specific techniques
Sign-making/NC

Vinyl cutters, laser-cutting machines, engravers and routers
have 2D motion systems that require smooth and
continuous vector lines.

To reduce points and for smoother lines,

set Precision (in Trace Settings) to 1mm. This tells TracTrix to
follow the original line but allows it to deviate within +/-
1mm for optimum smoothing and minimum vector points.
This effectively adheres to the line but reduces vector points
by ignoring the small jaggies that are present in all raster
files. Each vector point is a signal for the machine either to
stop, start, or change direction. Fewer vector points allow
the machine to cut longer and smoother continuous lines.

When the vectorization is complete the blue vector lines are displayed on screen.




e Save your work. It will be named ‘tawademo.cal. TRX'. This .TRX file contains a copy of your
original raster image and the vectors created from it.

The .TRX format is used only by Trix DrawingCenter and TracTrix to save and store work. It can
contain raster only images or hybrid raster with vector images.

Exercise

In your own time we suggest you experiment with the effect of changing the Precision setting
in the Trace parameters box. Start by zooming in on the vectors we've just created. Note how
closely they follow the original center lines. Then delete all the vectors (see the instructions
earlier on how to do this). Change the Precision settings and vectorize again. Zoom in and
examine the new vectors. You'll see how this change in setting affects how closely TracTrix
follows the original. See the examples opposite. Although TracTrix settings are simple, it pays
to think about them before each vectorization. Once you have experimented a little with the
effects of changing the settings you'll find it easy to establish the optimum settings.

Successful Vectorization Rule #4:
Careful selection of trace settings will optimize the type and quantity of vector entities you create.

Editing the vectors that you created

TracTrix provides tools to edit the newly created vectors. Open the <tawademo.cal. TRX> file in
your Examples folder. Use the Zoom tool to zoom in on the text in the lower right-hand corner
of the image. You should see something like this:

awd

We will use the vector editing tools to tidy up the vectors that represent the text. Click on the

Vector editing tool k icon. Start by clicking once on any blue vector. The entire vector 'entity’
is selected and appears as a dashed line.

10



Position the point of the cursor arrow over any part of the
dashed line. Hold down the left mouse button and drag. The
entire vector entity moves. Release the mouse button. To

return the vector to its original state select, = Undo from the
top menu bar or type Alt-backspace.

Click on the vector line again to select it. Position the cursor
exactly on the center of one of the small circles or squares on
the dashed line. These small squares or circles are called
corners. Again hold down the left mouse button and drag. This
time the dashed line on either side of the corner moves while
the remainder of the line remains in its original position.

You will also see that when you select a corner it 'sprouts’ gray lines. These gray lines and
squares are called handles. They control the shape of a line on either side of a corner (corners
at the end of a vector line sprout only one handle).

Position the cursor over a solid gray square at the end of a handle and hold down the left
mouse button. Slowly drag the mouse. Watch how the shape of the line changes.

Some corners are represented as circles, others as
squares. Try manipulating the handles on each type.

You can also snap two lines together to

When you select and move a handle on a square corner form a single connected line using the
the vector line adjacent to the handle changes shape but Polygon and Snap.

the vector line on the far side of the square corner does Select the endpoint of a line. The cursor
not move. changes to show a box with a key icon.

. . Continue dragging until the points snap to
When you select and move a handle on a circular corner it 99ing P P

changes the shape of the lines on both sides of the
corner. Circular corners are called locked corners because
the shape of the line on one side of the corner is 'locked'
to the shape on the other side. The square corners are called unlocked corners.

one another—the connection is indicated
when both vectors becone one dashed
entity.

Experiment with adjusting the shape and positions of the lines using the corners. You can also
delete entire lines once they have been selected. Use the Delete key for this.

You'll probably have noticed by now that each line segment in the vector lines created by
TracTrix is joined to its neighbor. This is because the ‘Beziers and lines’ box in the Trace settings
was selected prior to vectorization. To disconnect two lines use the left mouse button to select
a corner point where you want a disconnect to occur (you'll see the handles appear when the
corner has been correctly selected). Right-click/Break. Deselect the vector line by clicking
outside it. The dashed appearance changes to a solid blue line. Then reselect it. Hold the left
mouse button down and drag the line. The line segment on the other side of the break remains
in position. You can also insert a break in the middle of a selected vector line segment by
putting the cursor where you want the break to occur and hold down the right mouse button
and proceed as above where you separated lines at a corner. Entirely new vectors can be added
by using the vector line, arc, circle or Bezier tools available under the Start tab.

11



Experiment with vector editing until you are comfortable with manipulating the vectors.

Successful Vectorization Rule #5:
Edit vectors in TracTrix (where you have access to specifically-designed tools)

before you save in a specific CAD format.

Saving your vectors to CAD

Before saving the vectors in a specific vector file format refer
to your CAD, CAM, NC or Design software manual to check
which vector file format or formats it will import or open.

Click the Drawing &/ toggle to switch the raster layer off. For
this exercise we will export the vectors representing the Tawa
figure but omit the text box and base line.

Kk | Select an area of vectors in the top half of the image.

Now hold down the Shift key and select the lower-right box of 3
text—the remaining vectors in the Tawa figure are added to - : __ R :
the selection. The text box and footer line should be outside S
this rectangle.

For use with
the TracTri™
witarial

File HSC"*’E&S--- Enter tawavect as the file name and select the

output vector format you require, then click on Save.

TracTrix gives you the option to save the vector lines as any one of several CAD formats and
automatically appends the three-character extension to the tawavect name. For example, if
you selected DXF output TracTrix has saved the file as <tawavect.dxf>.

Open your CAD, NC or Design software and follow its instructions for importing the vector file
that you have just created. TracTrix does not need to be open while you do this.

Using OCR to convert raster text to ASCII

In this section of the tutorial we convert raster text to vector text. In Exercise 1 we demonstrate
text recognition by converting an example file using our supplied text recognition library. In the
next exercise we create a new text recognition library.

Using an existing text recognition library

In TracTrix, navigate to the Examples folder in the TracTrix folder and open <Planl.tif>.

12



The image shows an architectural drawing. We want to create vectors from the centerlines of
the drawing and we want to create ASCII text from the characters and digits in the raster image.
The text is processed first—this enables us to delete the raster text before vectorizing the
linework.

k1
. g ® . A
Click on the Character Recognition icon on the Tools tab. 34
haracter
Recognition

In the Text Recognition window select Settings, and check that the Active network
field at the foot of the window shows a file path to
‘DefNet.ndb.’

If it does not, click &), navigate to the Program
Files/TracTrix folder and select it.

Click on Start, then on |_Statt text recogrition |, ' =

C #;\ IJ"‘e:\Trme E\DeNetnds _6
TracTrix 'looks' through the drawing to locate text regions T W

and presents them one at a time in the window.

The large field shows the raster text being processed; the £
text field underneath shows TracTrix” interpretation of this | #7
text (also shown in red behind the raster text window). =2

Use the slider for zooming the raster text. Also, as you can =

see at the bottom of the window, there is a font specified. routege i Cltos ottt B[]
Change the TrueType font by clicking on the Font buttons Cor oo I e )
and making the necessary adjustments. _—
If TracTrix converted the text correctly, use Ll to move on f" ______________________________________ _ =

; * S ;
tco the; .next te?<t string. All the text s,.hould be correctly ser 17”/9 0/- O,
identified until you get to the drawing number 44901_01. =2 T
Edit the incorrectly converted text in the text field and e = Eal B e
confirm the change by clicking on the | _Change | button. Teabg {1607 |l Gt o]

You have now reviewed and edited each text row. Click
OK.

TracTrix asks ‘erase the raster under the converted text’. Click Yes
and the raster text in the drawing is replaced with ASCII text (in the e e rectee iyler e et it

same color as the vector layer in which you are working).

TracTrix may have ignored solitary raster 'T' and 'G' shapes where
they are boxed-in by lines. This occurred because Allow single characters was left unchecked in
the OCR settings. In instances such as this, use the Text tool # to add the characters.

Now that you’ve completed the text conversion you can move on to vectorizing the lines.

ﬁ Click on Vectorizing; a dialogue box appears. Choose Architecture from the drop-
I down menu of predefined settings and click [_Stat__].

Vectorizing .. . . . .
All the raster elements remaining in the drawing are vectorized as line work that

13



can be edited as needed. Finally use File HSC"VEES--- to export the CAD format you require.

Creating a character recognition library

There are an almost infinite number of text styles in
drawings. In addition to the many typefaces produced
as output from CAD programs there are characters
manually created using stencils and, particularly on
older drawings, hand-drawn text.

TracTrix provides the user with the ability to create and
save custom libraries (or databases) of raster image text
and the equivalent ASCII text. For example, you might
create a specific library to be used when converting
drawings hand-drawn by one or more individuals. This

TracTrix creates text recognition libraries in
two stages. In this first stage you create a raw
database which contains ‘pictures’ of the
raster text characters and the actual text
which you choose to associate with them.
When you have completed this database of
pictures and text, TracTrix will take care of
the second stage by processing it using
neural network technology to create the text
recognition library. These text recognition

libraries are called net databases.

library would be trained to recognize the characters
created by each of them. For another set of drawings where the draftsperson employed a
unique set of stencils, a separate text recognition library would be created.

The initial creation of a library requires a semi-manual conversion process. This can be quite
time-consuming compared with the subsequent automatic conversions. This time is the
investment necessary to enable later automatic conversions of drawings from the same type or
font 'family'.

For this exercise we'll recreate a text recognition library suitable for use with Plan1.tif. (If you
have just completed the exercise above, close the file, do not save changes, and reopen it so
that no vectors are showing.)

Click on the Character Recognition icon on the Tools tab and select Training. %1{

Character
Recognition

Click on B/ to create a new raw database. Name it tutorial.rdb and save it in the
TracTrix/Examples folder.

Open the database--click @|and select <tutorial.rdb>.

Text recognition 3]
o . .
Click | Start search for characters |. TracTrix searches the raster
- = image identifying the raster elements which it sees as
b characters. The first raster character is presented in the
| “ | large window.
Faw datsbase  C\Program Fles\Trac Tax §'Examples'tutonal i |
teva b Bomane) T === | Use your keyboard to enter the actual character in the
E [ Corcd ][ e |

smaller window below. Use Enter to save the character
and move on to the next one. You should find that, although there are quite a large number of
characters, rapid progress can be made.

When all the characters have been manually identified click B/, and then click|_Createret.. | to
save a new net database—save it as tutorial.ndb. Wait patiently as TracTrix saves this net
database which contains the text recognition information created from the unique text in the
<Plan1.tif> image.
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In order to use the <tutorial.ndb> that you have just created select it in the Text Recognition

Settings Active network box at the foot of the window.

Begin the OCR process by selecting | Stattextrecogniion |. This repeats the first exercise in this tutorial
using your new net database. You may need to change the font to one that closely resembles
the one on the drawing. As you've just used <Planl.tif> to train and create the <tutorial.ndb>
net database, the results of this conversion will be satisfactory, as you expect.

A fairer test and illustration is to take a set of your own
drawings created by one individual draftsperson or employing
the same fonts, open a typical drawing from the set in TracTrix
and use the training function to develop an .rdb database. Once
you have identified all the characters, create an .ndb file from
the .rdb as you did above. Then select and use this .ndb file on
the remainder of the drawings from your set. If the characters
used in the training file were reasonably representative of
those in the entire set you should find that text is correctly
recognized most of the time.

Converting color images to vectors

The ideal color original contains only spot colors, as opposed to
blended colors or colors that fade into one another. We have
included an example of such a file in the Examples folder. The
file name is <spotclr.png>. Open the file and zoom in on the
colors and color boundaries in this image to see examples of
pure spot colors.

Real life rarely provides such simple images. Now go to File —
Open and choose the file <Blume.jpg> from the Examples
folder.

image in its original state,
TracTrix would convert the
colors into 256 individual vector
layers. This is unlikely to be of
practical use. Instead we
change the raster <blume.jpg>
so that it contains a
manageable, relatively small set of colors for TracTrix to

Additional characters can be
added to the raster database
(rdb) files at any time from new
drawings. When the rdb
database is then recompiled into
the neural net database (ndb),
file recognition will be improved

across the entire set.

'}

L
Q__.

‘il h
"I
N R

The <blume.jpg> flower image is far more typical of a color
image. It has thousands of different color hues. Converting this

TracTrix places a limit of 256 colors
on its separation tool. 8-bit images
can contain up to 256 colors. All
images of more than 8-bit depth
must therefore be converted to 8-bit
before they can be processed by
the color separation tool.

vectorize. These colors have to be ordered in such a way that the resulting vectors reasonably
depict the petals and leaves in the original image. This is no small task, given the multitude of

colors and tones, which run together in the original image.
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The process used to achieve this is known as color separation. This separates all the colors in
the image into a few groups, each containing similar colors. Once this is done each group is
replaced with a single spot color that represents the colors in the group.

To demonstrate this, click gl Color Separation under the Draw tab. A window appears stating: This
file contains more than 256 colors and must be converted. Click OK.

TracTrix then analyses the image and reduces the number of
colors to a selection of 6, which it calculates as
representative of the original thousands of colors. The G
colors in the <blume.jpg> image will change to reflect this. DlPwioe
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Each group of colors is separated in the color separation g 3
window by a vertical line known as a delimiter. Use the scroll bar at the foot of the window to
examine how TracTrix has separated the original colors. The height of each colored bar
represents the relative quantity of pixels of that color. In effect we are graphing the distribution
of the colors. This graph is known as a color histogram.

It is possible to edit the position of each color. However, for the purposes of this example,
accept TracTrix selection of 6 groups and click on OK.

The blume image changes to reflect the reduction in colors
from 256 to six colors. Although
not as attractive as the original, Beauty is in the eye of the

the shapes of the petals and beholder. Our human eyes liked the
leaves can be seen cIearIy as original with its thousands of colors.
spot colors in the new image. TracTrix would have hated it. If you

are a vectorizing machine a few
Go to the vectorizing tool under | spot colors are your ideal.

F i ~J ' 4 the Tools tab. .= Click Adjust.
The trace settings box is displayed.

Select Outline as the trace setting (this will give us outline vectors around
the petals). Now vectorize it by clicking on Start.

The resulting vectors can then be edited in the normal way using the
TracTrix vector editing tools before they are exported to the required CAD
or NC format. Each color is saved to a separate vector layer for vector
editing.

Merging color groups

Sometimes TracTrix interprets more colors than there | "o - =
really should be for effective vectorization. You can
prevent this by intervening during Color Separation
and merging groups into single colors.

Re-open the original <blume.jpg> image and choose
il Color separation The window appears stating: This file
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contains more than 256 colors and must be converted. Click on OK. Again, six color groups are
created. You can manually merge two groups together as follows.

Place the cursor in one of the two columns to be merged. Click and hold down the mouse
button and drag. A cross-dashed representation of the group appears. Drag it to the target
group’s column. Release the mouse and the two groups will be merged into one new group.
This will reduce the number of groups and therefore the number of vector colors eventually
produced.

TracTrix starts its automatic color separation by estimating the number of individual color
groups to create. If you would prefer a greater or smaller number of color groups, use the slider
bar beside the Number of groups. TracTrix will recalculate and display a new set of groups.
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